
                                                                                      

Adr_Book  
Version 4.0 (32 bit)

            Navigation                         Reading this will be very helpful.
           File                                                File Handling and Import/Export
            Edit                                                Data Base Handling.
            Options                                    Display Features.
             Find                                            Seach and Find Records
            Dialing                                      Setup for phone dialing.
           Upgrade                                  Convert Shareware to Registered Version
           Merging Database Files

         Registration Info.        Please look at this one.
         Registration Form    Another good one.



    
Green Arrows:    The single arrows will move through the data one record at a time.
                                                  The double arrows will page through the data file four records at a 
time.



    
The File Menu

The File Menu allows for creating, maintaining, and printing. It has the following options:

         New                    Create a new database file.
         Open                  Open a database file.
          Save                  Save the current database file.
          Save_As      Save the current database to a new file.
         Print                    Print Address book, Labels, Envelopes.
         Import              Insert records into the database.
         Export             Export records to a file.
         Upgrade        Convert Shareware to Registered Version.
         Exit                      Exit Address Book.



File New Menu

This selection will close the current database file and prepare for entering data into a new 
database file.



File Open Menu

This selection will present the open file dialog box for selecting an exisiting database file to be 
load.



File Save Menu

This selection will save changes made to the current database file.    Saving the database file will 
also save most of the configuration items associated with the database file.



File Save_As Menu

This selection will present the save file dialog to allow saving a current database to a new file.



File Print Menu

This selection will present a variety of printing options. One general concept should be 
understood with regard to printing.    You do not have to print all of the records in you database.   
You can select which records to print by first using the find command. This will allow you to 
select a subset of your records and then only those records will be printed. The possible printing 
options are:

          Phone List Two Columns (Name and Number Only)
         Phone List (Condensed Name/Address/Phone)
          Pocket Size Address Book
         2-Up Labels 1 x 4 inches
          3-Up Labels 1 x 2-5/8 inches
          #10 Business Envelope: 4-1/8 x 9-1/2 inches
         Monarch    Envelope: 3-3/4 x 7-1/2 inches
          #6 Personal Envelope: 3-3/4 x 6-1/2 inches



Phone List Two Columns (Name and Number Only)

This will print the names and phone numbers in an easy to read two column format.    A dialog 
box is presented that lets you enter the Title of the report, fonts to be used, number of copies.    
Only one phone number can be printed with each name.    Check boxes indicate if this should be 
the home number or the work number.



Phone List (Condensed Name/Address/Phone) 

This print selection    trys to cram the Name, Address, and Phone numbers on a single line. 
Names and address may be truncated at times if it can not all be displayed. The font size used for
the address will be reduced to squeeze it in the allowable space. A dialog box is presented that 
lets you enter the Title of the report, fonts to be used, number of copies.



Pocket Size Address Book

This selection will print a quarter size address booklet. Quadrants are printed on the paper in a 
fashion    that when cut and folded will produce an address book with dimensions ranging from    
5 -1/2 x 4 1/4 inches to 4 x 2 3/4. The easiest way to see how this is accomplished is to simply 
give it a try.

You will first be given a dialog box to choose fonts, the booklet dimensions, and which fields 
should be printed in the booklet.    If you have a color printer, you are also able to specify 
separate colors to be used for each field printed.    After you select print, and your printer stops 
you are only half way through with the print job. A dialog box will appear asking you to remove 
the printed sheets and to reinsert them for printing on the reverse side.    After doing this press 
OK to continue to print the second half. 

You may need to collate the sheets before reinserting into the printer.    If you have a printer that 
requires you to shuffle the pages when you print several pages to get them in the proper order, 
then you will need to do this before reinserting the pages back into the printer.    You will need to 
do this for a Deskjet printer. 

When the second stage of printing has complete set the sheets of paper down so that the quadrant
with the page number 1 is face up.    It will be in the upper right hand corner. Next cut the paper 
in half.    Now if you let the paper lie as it was before you made the cut,    simply reach up and 
grab all of the sheets    in the pile that has quadrant page number 1. Place this stack on top of the 
other stack.    The last step is to pick all the sheets up, fold them back, hit them with a staple and 
it is done.



2-Up Labels 1 x 4 inches

This printer selection will print standard    1x4 inch labels. There will be two across and 10 down 
for a total of 20 per page.    A    dialog box will permit the font choice, number of copies, and if 
printing should be done with all capital letters.    Selecting the Positioning button will bring up a 
dialog box for alignment and starting label position.



3-Up Labels 1 x 2-5/8 inches

This printer selection will print standard    1x2-5/8 inch labels. There will be three across and 10 
down for a total of 30 per page.    A    dialog box will permit the font choice, number of copies, 
and if printing should be done with all capital letters.    Selecting the Positioning button will 
bring up a dialog box for alignment and starting label position.



Envelope Printing

This printer selection will print an envelope for the person whose name had the turquoise 
selection from the graphical address book. A dialog box will be presented that allows separate 
font choices and point size for the return address as well as the addressee. In addition you can 
select different point sizes for the first line of the return address and addressee. The Post Net 
code can be printed as well as a Note Line. 

The return address pulled into the dialog box comes from entries previously made in the Options 
Report Header dialog box. It was here that you could enter two possible return addresses. The 
two check boxes below the return address field labeled #1 and #2 will toggle between the two 
previously defined return addresses.    The edit box containing the return address can always be 
edited to change any or all text in the return address.

The addressee information was pulled from the turquoise selection from the graphical address 
book.    The work or home check boxes determine which address to use. The edit box containing 
the addressee can always be edited to change any or all texts in the addressee.

The Post Net code for the zip code can be printed.    The zip code that will be used for the Post 
Net is displayed in a special field.

To put a note on the envelope you need to select the NOTE button. This brings up a dialog box 
that lets you select from some predefined text strings, or you can edit your own. You may also 
select the font and point size for the note text string.

Though complete printer control of envelopes is not supplied, you can click on This Side , The 
Other Side, Front, and Rear to assist in envelope alignment. If you have a DeskJet printer try 
selecting The Other Side and Rear.    



Address Book Features

This section describes the features of the Address Book Graphics Display and Name List Box.    

The Address Book area permits navigation by using Tabs and Arrows. Clicking on the 
Alphabetic Tabs will take you to the first record whose last name begins with that letter. If there 
is no name starting with that letter no movement will be made. Clicking on the Green Arrows 
moves sequentially foreward or backward through the records. The single arrow will move one 
record while the Double Arrows will page through four records per time.

The Address Book area is also used to determine the active record. The active record is the one 
highlighted in turquoise. To highlight the record of interest simply click on the name in the 
Address Book. The active record will be the one used if you click on the Edit Button or select 
Edit from from the pull down menu. The active record will also be the address copied into the 
clipboard when selecting copy from pull down Edit menu.    Double Clicking on the name 
highlighted in Turquoise will cause the Edit dialog box to pop up for that record. The active 
record will also be the record used when you choose to print an envelope.

The List Box is the fastest way to locate the person you are interested in.    Typing the name in 
the edit portion of the List will immediately highlight that person in the Address Book display. 
The best way to do this is to click anywhere in the scrollable list area.    This immediately causes 
the name to be placed in the edit protion of the list box. At this point, you need simply to put 
your fingers on the keyboard and begin typing the name of the person you are searching for. The 
name will pop up in the address booklet as you type.

By using the scroll bars you can easily look at the names in your database. Clicking on a name in
the scroll area will make it the Active record. Double Clicking on a name in the scroll area will 
call up the dialog box for making modifications to the record.



Import

Importing and Exporting is the process of exchanging data between applications by way of text
files. For Adr_Book, importing also implies merging of records. If you import records into an 
existing Adr_Book database file, you will be adding records to that database.    These text files 
are often referred to as ASCII files.    These files contain separated text strings that correspond to 
individual record fields. i.e. Last Name, First Name, Phone Number, etc.    Most database 
and spreadsheet programs are capable of producing ASCII files containing their record 
information in separated fields.

When you installed Adr_Book onto your System, you should have received a Microsoft Write 
file. The file name is adrbook.wri and the icon name after installation was Tutor.    Refer to this 
document for a step by step example for importing and exporting.

If you are attempting to import data into Adr_Book and not exactly certain how to proceed I 
would first suggest you read the Import / Export section of the document mentioned above. Next 
I would simply do some testing by using Adr_Book to Export some data and then Import this 
data back into Adr_Book.    When you do this, use a text editor to actually view your generated 
file.    This will give you a good understanding of what needs to be accomplished when moving 
the data in from some other application program. Good luck and have fun.



File Exit

Exit the Adr_Book program.



Edit_Menu

The Edit Menu manages the database file through Adding, Deleting, and Editing.

            Add              Create a new record.
           Delete      Delete a record.
           Edit              Modify a record.
           Copy          Copy to Clipboard



Copy to Clipboard

Selecting Copy will move a copy of the currently active Name and    Address to the Clipboard. 
This can then be used for inserting into your word processor etc.



Adding and Editing

Adding or Editing goes to a dialog that lets you do exactly what you would expect. The only 
point of interest is a dialog button that says "Add / Next".    If you have entered the dialog box for
Adding, "Add / Next"    will cause the record to be added and present you with cleared fields to 
allow entering of another record. If entered for Editing the "Add / Next" will bring up the next 
sequential record for editing.



Delete

Selecting Delete will bring up a dialog box asking if you really want to delete this record. The 
record to be deleted will be the one currently highlighted in turquoise.



Options Menu

This menu permits setting configuration items.

          Display                            What will be displayed on the Address Book.
          Report Header      Titles and Return Address for printing.
         Mode (US/International)                      Address entry field.



Mode (USA/International)

USA mode allows for entry of State and Zip code in a fasion that is typical in the United States.   
International mode gives four complete address lines for entering State, Zip and Country in any 
appropriate fashion. For a better explaination simply select this option from the menu and read 
the description provided.



Report Header

The dialog box presented allows you to enter two text lines that will be used at the top of printed 
reports.    This is also the place where default return addresses are entered for use when printing 
envelopes.    



Display

The dialog box presented allows choosing what information will be displayed on the graphical 
address book.    Because there is limited room on the display not all record elements can be 
displayed.

By selecting the Note check box you will see a Note.. text string highlighted in red appear on the
graphical address book for any record containing note text.    By clicking anywhere in this red 
area a pop up list box will appear to display the text. Clicking anywhere will cause the list box to
disappear.



Flags

Entering codes in the Flags Field permits printing, exporting, and displaying records of particular
interest.    The operations that can be used with the Flags are OR, AND, SEQ, and NOT. Listed 
below are explainations of how you would enter codes in the dialog boxes for printing, exporting
or displaying records.

The OR option will select all records that have any of the codes you list in flags field. Imagine 
you entered a flag code of T for friends that play Tennis and an R if they like to play 
Racquetball.    Now if you felt like playing Racquetball or Tennis and wanted to find people who 
might be interested in either of these sports,    in the flags field of the dialog box you would put 
TR and then select the OR check box.

The AND option will only select records if all codes listed are present in the flags field for a 
record. Imagine you needed to find a woman to fill out a golf foursome. If you used the codes F 
for female and G for golfers, you would enter an FG in the in the flags field of the dialog box 
and then select the AND check box. 

The SEQUENCE option will only select records that have a matching string of characters.    If 
you used words like JULY and MARCH to represent the month of individuals birthdays, 
entering the word JULY in the flags field of the dialog box and then selecting the Sequence 
check box would list people with birthdays in July.

The NOT check box reverse the sense of the match. In the example above for finding July 
birthdays, if the NOT check box was also selected you would have a list of all people who did 
not have a birthday in July.



Registering ADR_BOOK Ver 4.0 (32 bit)
First of all, if you find this program useful that's GREAT!    I would like to hear from you with 
any suggestions you have, no matter how trivial.    Feel free to write to my address below, send 
E-mail to mikeg@alaska.net or call (907) 278-1231

If you have decided that you like ADR_BOOK and would like to register, please send a check 
for    $23.00    in US funds plus $2.00 for shipping and handling.    ($5.00 shipping and handling 
for International orders.)    Make payable to  Brown Bear Software or to Michael Gardner.    I 
make every effort to ship in 24 hours.    Mail to:

                    Michael Gardner
                    1231 Redwood Ct.
                    Anchorage,    AK    99508

Please send the registered version to:

Name:

Address:

Please ship    ________    copy(s)    of    Adr_Book

Price $23                    ________    ( 20% discount on 5 copies,    30% discount 10 copies or more)
Shipping                      ________    ( $2 U.S. orders,    $5 International Orders)

Where did you find    Adr_Book _______________________________ 

Any Suggestions:



Merging Database Files
 
By example let us say you have created three database files: file1.adr, file2.adr, and file3.adr.    
To merge these into a single database file you    first need to open one of the files and read it into 
Adr_Book.    Of course you know how to do this, and lets say you load file1.adr.    To merge 
file2.adr select Import from the File menu.    When you get to the Import dialog box click 
Open... From the Open Dialog Box click on the arrow down by the List Files of Type:. You will 
see an option that says Database Files(*.ADR).    Click on this.    Now in the file list above you 
will see your    database files.    For this example you would see file2.adr. Opening this will then 
merge file2.adr with file1.adr.    Do the same operation again for file3.adr and you will have a 
single database file. Not so bad!



    File Export

Exporting is the process of writing Adr_Book database fields into a text file so they can be used 
by some other application program.    I would like to refer you to the Import Topic since there is 
more verbage on the actually process that takes place. 

The entire database does not need to be exported.    You can export only selected records. You 
select the records by using the find command.    You simply need to execute the find command 
before exporting your records.

The Export command can be used very effectively to produce merge files for your word 
processing program.



Find Menu

The Find feature of Adr_Book is a means of locating an individual record or a group of records. 
The find feature of Adr_Book works a little different than the find feature in many other 
applications. Rather than simply locating the first record that meets a search request, Adr_Book 
will present at once all    the records that met a given search request. For example if you had 500 
records in your database file and a search matched 50 records that had a ZIP CODE starting with 
"995" the address book would now display only those 50 records.    This has implications for 
printing.    Printing labels after the search just described would result in only 50 records being 
printed. Those 50 records that matched a ZIP CODE starting with "995".

There are two modes to the Find command. There is the Basic method and the Complete method.
The basic method is the default. You can specify which method to use by selecting Type under 
the Find Menu Option.



Upgrade Cost for a Registered Owner
As a registered owner of Adr_Book you are entitled to free upgrades for one year.    You are able
to perform this Upgrade Procedure by yourself.    At the end of the one year time period an 
upgrade fee is required if you would like the latest release of the program.    The upgrade fee is 
$15 US .    Purchasing an upgrade will once again entitle you to free upgrades for one full year.    
The best way for me to get the latest registered copy to you is via Email.    Contact me at 
mikeg@alaska.net.    If this is not an option for you,    simply print the registration form and postal 
mail it to me.    For the price put $15 US.    A $2 USA shipping and handling is required and $5 
for international orders. I hope this meets with everyone's approval.



Upgrading a Shareware version of Adr_Book to a full registered version.

Version 4.0 of Adr_Book provides a means for registered users to get free upgrades for one year 
after purchase.    It has always been difficult to inform registered users of a new release and to 
provide upgrades in a cost effective manner.    The Upgrade feature of Adr_Book    solves this 
problem.

Note: This menu option can only be selected from a Registered verion of Adr_Book.

When you obtain a registered version of Adr_Book the date of your purchase is stamped into the
software.    You can see the registration date of your copy by selecting About Adr_Book under 
the Help Menu.    You will see a date that appears something like:  Day 265 of 1996. Also note 
that the top line of the About Adr_Book    Dialog box of a Registered version will say: 
Adr_Book Version #.#      (The #.# values will vary depending on the release version.)

The latest shareware version of Adr_Book can be found on the Internet, BBS's, Compuserve, 
AOL, and CD-ROM distributions.    The About Adr_Book dialog box of a shareware version is 
slightly different from the registered. On the shareware the first line will say Shareware 
Version #.#    The next line will also give a date indicated by day and year.    This is the release 
date for the shareware version.    If this date is no greater than one year from the date of your 
registered version, you will be able to convert the shareware version to a fully functional 
Registered version.    For example, lets say your registered version has the date     Day 265 of 
1996.    From the Internet you pull down the latest shareware version from my homepage 
http://www.alaska.net/~mikeg. On this shareware version you see that the release date is  Day 
320 of 1996.    Since this is less than one year from the time you purchased a registered version, 
you will 
be able to convert it to a fully functional Registered Version.

Here (at last you say) is how it is accomplished. Unpack (unzip)    the new shareware version on 
your hard drive in a temporary    directory - C:\ADBOOK##.      The executable file unpacked 
will be ADRBOOK.EXE.    It is this executable file which must be modified to produce a 
registered copy of Adr_Book.

To accomplish this, run your registered version of Adr_Book and from the File menu select 
Upgrade.    You will be prented with a dialog box.    Click on the Open button. The file open 
dialog box will appear.    Use this to locate C:\ADBOOK##\ADRBOOK.EXE.    Open the file.    
The ADRBOOK.EXE will be converted to a registered version. A dialog box should pop up 
saying that the conversion is successful.

Now you can install the software in the normal fashion with Add Remove Programs found in 
the control panel.

The last step to verify the conversion is to run the program C:\ADBOOK##\ADRBOOK.EXE.   
Do this and select    About Adr_Book under the Help Menu. You will notice that it no longer 
says Shareware Version #.#.    It    now says Adr_Book Version #.#.    Also the date will no 
longer be  Day 320 of 1996.    It will now have your original registration date of     Day 265 of 



1996.    This is now your new registered version to run.

If another shareware version is released on Day 65 of 1997 you could once again follow the 
steps above to convert the program to a registered version.    Note that your original registration 
date is always carried forward.    You can continue to upgrade new shareware releases for a 
complete year after you obtain your registered version.

A newer version of Adr_Book will read the database file from a previous version.    An older 
version will not read the database file of a newer version.    For this reason, you should make a 
backup of your database file before you begin to use a new version of Adr_Book. 



Find Basic Method 

The basic search record locates strings in record fields. You can select the individual fields to 
search.    For example you could specify to only search in the Home Address.    You can specify 
the match to be case sensitive. You can specify a match to occur if the string is contained 
anywhere in the field, if the string is at the beginning of the field, at the end of the field or if the 
string exactly matches the field. 

The basic method can be used for most needs. For example if you entered the words "Christmas 
Card" in the notes field for some of your records you could locate all of these records by simply 
searching for the string. You would be presented with the list of records that contain the string. 
You could then print labels for only those records.



By default Upper Case letters are the same as Lower Case letters when comparing strings. If a 
comparison is case sensitive then an Upper Case "A" will not match a lower case "a".



Find Complete Method

The complete method allows for two additional methods of locating records not found in the 
basic method. Examples are available in the tutorial.

The first additional feature is the ability to search only in records from a previous search. Here is 
a real world example that you might use. Let's say you want to find all of the people who 
registered Adr_Book in 1995 who live in Florida.    (Alright so it isn't a too real world) 

Here is how you would find those people. Your first search would be for the string "/95" in the 
""Entry Date" field. Enter the search string and click on "Find New". After doing this you would 
be presented with the results of the search. Going to the search dialog box again you would enter 
"FL"    (Florida State Code) in the search string and click the "Home Address" field.    You would 
now click on the "Find Subset" button which tells Adr_Book to only look for this string in the 
previously selected records.    This method effectively allows you to perform AND operations. 
"Show me all people who registered in 1995 AND were from Florida.

The second additional feature deals specifically with the Flags Field. It is highly recommended 
that you consult the tutorial document for a detailed example of using this feature. 

To get to this option you need to click on the "Flags Detail..." button. Characters entered in the 
Flags Field will be compared in a case sensitive fashion. 
Generally you enter single characters for the search pattern. These are single characters that you 
choose to be meaningful. You could decide that the lower case "r" will indicate racquetball 
players and and lower case "t" are tennis players. By putting a "t" and an "r" into the seach string 
and selecting "OR ( containing any )" you would find all records that contain either a "t" or an "r 
in their flags field. If instead you selected the "AND    ( Must contain all ), then only the records 
that contain both letters will be found. 

You can also use this method to locate a sequence of characters in the Flags Field. You could do 
this particular search with the Basic Method". There is one difference, however. 
You have the ability here to check the "NOT ( Reverse Sense of Selection"). You might have the 
characters XMAS in the flags field of some of your records. If you set up a SEQ seach for this 
string and also check NOT you would be returned all records that do NOT hold the XMAS string
in the flags field. You can use this NOT operator with the AND and OR searches well.

You can also combine this specific flags search method with main string searching in all fields. It
is important to note, however, that whatever search you perform in this flags field search will 
take place prior to any general string search. For example lets say that you did a search in the 
"Flags Detail" for all racquetball AND tennis players, hit OK and returned to the "Find Text 
String" dialog box.    At this point you will have located all of these records. Now if in the Notes 
Field you always entered "Male" or "Female" I could additionally find all female players by 
doing a search for "Female" in the Notes Field. 

There it is.    Experiment.    Good luck.    Have fun.



ADR_BOOK Ver 4.0 (32 Bit)
This is a shareware product produced by  Brown Bear Software. - which is really just another 
name for me, Michael Gardner. 

There are several ways to register this program.    One way is to click on Registration Form 
which will bring up a form that you can print and postal mail to receive your registered version. 

The second method is through Email.  mikeg@alaska.net    By this method you will Emailed an 
attached .zip file containing the registered version.    To do this simply contact me by Email and 
the necessary arrangements will be made.    This method has several advantages.    First, you will 
get the latest version right away. Second, there is no shipping and handling fee, so the entire cost 
to you is only $23 US.    I particularly like this method because this way I can easily verify that 
you have receive the software.    (I always worry about the postal mail) 

You can also register by calling (907) 278-1231.    This number is in Alaska USA.

If you are a current owner of a registered version of Adr_Book, and need to purchase an upgrade
version please click on Upgrade Fee.

No matter which method of registration you choose, we work very hard to get the registered 
version into your hands as quickly as possible.

Feel free to examine this product completely.    If you find that you are using the product, please 
do the    RIGHT thing and Register. 

As a registered user :
1. You will receive the latest version of Adr_Book.
    
2. The restriction of allowing only 40 records in the database file will be removed. The registered
version can hold over 10000 records in a single database file.

3. You are entitled to free upgrades to the latest version for one full year.  Upgrading shareware 
explains how this is accomplished. You have the responsibility    and ability to obtain the latest 
shareware version and converting it to a registered version. In other words it is just too difficult 
for me to notify everyone of new releases.    The best way to be alerted to any new releases is to 
moniter the    Brown Bear Software home page at http://www.alaska.net/~mikeg/.

I could list other registration benefits like technical support,    but the truth is that the best reason 
for registration is you will feel better, I am quite sure I will feel better, and I am absolutely 
positive, Alberta, my much better half, will feel better. 

Contact me for any questions:

            Internet Email:      mikeg@alaska.net
            WWW:      http://www.alaska.net/~mikeg/
            Phone:  (907) 278-1231





Dialing
 It is necessary to activate this feature before you can actually click and dial.    Once you have set 
up this feature, clicking on the Yellow and Black phone number in the address book display will 
initiate a call. To Enable dialing check the  Enable Dialing check box. Select OK to save this 
configuration.    Remember, if you want to save this as a permanent configuration setup, you 
must issue a Save command from the File Menu.

If you need to prefix all phone numbers for an outside line, you can enter the number or number 
sequence into the prefix box.    This is often used, for example, to hold a number like nine (9) to 
obtain an outside line from an office building.

There are two optional number strings.    Appropriately titled Option #1 and Option #2. These 
strings can be inserted before the phone number you are dialing.    You have the opportunity to 
insert them at the time you dial the number.    This is after you click on the Yellow and Black 
phone number.    They can each hold 25 characters.    The default values are "1" and "011".    You 
can use this to insert for making a long distance call or an International call.    You could use 
these to enter a credit card dialling number. You might note that the comma character    will cause
your modem to pause. All of this should allow you to successfully meet some complicated 
dialing needs.

When a mouse click is received on a phone number a dialog box will appear allowing you to 
include option strings #1 and #2. The dialog box will also show exactly what number will be 
dialed. Clicking OK will dial the number.

Speed dialing is a means of skipping past the intermediate dialog box.    This is accomplished by
either clicking the the black and yellow phone number with the right mouse button or by holding 
the the control key (Ctrl) and clicking with the left mouse button. This will cause the number to 
be dialed immediately. 

There is a check box associated with the Option numbers to indicate if they should be included 
when Speed dialing. 




